This reference design demonstrates how to connect an EtherCAT ET1100 slave controller to a C2000 Delfino™ MCU. The interface supports both de-multiplexed address/data busses for maximum bandwidth and minimum latency, and a serial peripheral interface (SPI) mode for low pin-count EtherCAT communication. The slave controller offloads the processing of 100 Mbps Ethernet-based fieldbus communication, thereby, eliminating CPU overhead for these tasks.

Contents

1. Introduction ................................................................................................................... 2
2. System Overview ............................................................................................................ 4
3. Getting Started (Hardware) .............................................................................................. 12
4. Getting Started (Firmware) ................................................................................................ 21

List of Figures

1. TMDSECATCNCD379D Block Diagram ........................................................................ 3
2. TMDSECATCNCD379D Adapter Board ......................................................................... 4
3. TMDSECATCNCD379D ControlCARD and Adapter Board ........................................... 5
4. EMIF PDI Timing Diagram ............................................................................................. 5
5. Block Diagram .............................................................................................................. 6
6. F2837x SPI and EMIF Connections to the EtherCAT Slave Controller ......................... 6
7. EMIF Interface to ET1100 EtherCAT Slave Controller ................................................ 7
8. SPI Interface to ET1100 EtherCAT Slave Controller ................................................... 7
9. TMS320F2837xD Functional Diagram ........................................................................... 9
10. DP83822 Functional Diagram ...................................................................................... 10
11. SN74CBTLV3245A Functional Diagram ....................................................................... 10
12. SN74CBTLV3257 Functional Diagram ......................................................................... 11
13. Stacked F28379D ControlCard + EtherCAT Adapter Board .......................................... 12
14. EtherCAT Test Setup .................................................................................................... 12
15. TwinCAT Runtime Icon in Windows Toolbar .............................................................. 13
16. TwinCAT Runtime Dialog Box .................................................................................... 13
17. TwinCAT3 XAE Desktop Icon ....................................................................................... 14
18. TwinCAT3 Icon in Toolbar ........................................................................................... 14
19. Visual Studio Menus for TwinCAT3 ............................................................................. 14
20. TwinCAT3 New Project Dialog ...................................................................................... 14
21. TwinCAT3 EtherNet Adapter Dialog .............................................................................. 15
22. TwinCAT3 Discovery of Ethernet Adapter ..................................................................... 15
23. TwinCAT3 Master Scan for Slaves and Free Run Activation ......................................... 15
24. TwinCAT Solution Explorer Showing EtherCAT Master (Device 2) and Slave (Box1, TI_C2kESC) ................................................................. 16
25. EtherCAT Adapter Board LED and Switch Locations .................................................. 17
26. TwinCAT Project EtherCAT Tab .................................................................................... 18
27. TwinCAT "Smart View" Slave Properties Window Showing Blank Slave .................... 19
28. TwinCAT3 EEPROM File Dialog .................................................................................. 19
29. TwinCat "Smart View" Slave Properties Window Showing Programmed EEPROM ...... 20
1 Introduction

1.1 Features

• High-Performance Real-Time Control MCU Paired With Low-Latency Ethernet-Based Communication
• High-Bandwidth, Low-Latency Interface to Beckhoff ET1100 EtherCAT Slave Controller
• Supports Both Asynchronous Parallel and SPI Connections
• Glueless Interface
• Eliminates CPU Overhead for EtherCAT Frame Processing

1.2 Applications

• Industrial Drives
• Servo Motor Drives
• Manufacturing Robotics
• CNC Machinery
• Remote I/O
Figure 1. TMDSECATCNCD379D Block Diagram
1.3 **DesignDRIVE**

For more information on DesignDRIVE technology for industrial drive applications, see the following links:


2 **System Overview**

2.1 **System Description**

The TMDSECATCNCD reference design is an adapter board for TI F2837x controlCARDs. When coupled with a C2000 MCU, it uses a Beckhoff ET1100 EtherCAT Slave Controller (ESC) and TI Ethernet PHYs to enable the creation of EtherCAT slave nodes. The adapter board format uses a 60-pin high-density connector that can support both asynchronous parallel and SPI interfaces.

This user's guide illustrates how to set up the EtherCAT adapter board module, initialize the ET1100 subsystem for first use, and install and configure the Beckhoff TwinCAT 3 software for use as an EtherCAT master in a test setup. Example code is provided to configure both SPI and external memory interface (EMIF) interfaces and run simple read and write tests across an EtherCAT network.
2.2 Key System Specifications

Table 1. EMIF Configuration and Timing Settings for ET1100 PDI

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
<th>VALUE</th>
<th>DELAY (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA</td>
<td>Read-to-Write Turnaround time</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>RHOLD</td>
<td>Address and CSn hold after OEn LH edge</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>RSTROBE</td>
<td>Read Strobe time in units of EMIF Clocks</td>
<td>64</td>
<td>320 ns</td>
</tr>
<tr>
<td>RSETUP</td>
<td>Address and CSn to OEn assertion delay</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>WHOLD</td>
<td>Write Hold time after WE deassertion</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>WSTROBE</td>
<td>Write Strobe (WE) width</td>
<td>2</td>
<td>10 ns</td>
</tr>
<tr>
<td>WSETUP</td>
<td>Address and CSn setup time to WE assertion</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>EW</td>
<td>Extended Wait Mode</td>
<td>ENABLE</td>
<td>-</td>
</tr>
<tr>
<td>SS</td>
<td>Strobe Select Mode</td>
<td>DISABLE</td>
<td>-</td>
</tr>
</tbody>
</table>

(1) F2837x system with Fsysclk = 200 MHz.
2.3 Block Diagram

Figure 6 shows the block diagram of the SPI and EMIF interfaces. In both configurations, the F2837x runs the EtherCAT slave stack while the ET1100 is used to offload the EtherCAT Slave Controller (ESC) frame processing, FMMU, and SyncManager operations.

Certain pins on the ET1100 are used on both the SPI and asynchronous interfaces, which requires the SN74CBTLV3257 mux and SN74CBTLV3245 buffer to steer these signals to the appropriate GPIO on the F2837x MCU.

The EtherCAT adapter board features an on-board DC-DC 5V–3.3V converter, which allows the 3.3V VDD to be either sourced from the C2000 controlCARD or generated locally from an off-board 5V source.
2.4 **Highlighted Products**

2.4.1 **TMS320F28379D**

The Delfino TMS320F2837x is a powerful 32-bit floating-point microcontroller unit (MCU) designed for advanced closed-loop control applications such as industrial drives and servo motor control; solar inverters and converters; digital power; transportation; and power line communications. Complete development packages for digital power and industrial drives are available as part of the powerSUITE and DesignDRIVE initiatives. The F2837x supports a new dual-core C28x architecture that significantly boosts system performance while integrated analog and control peripherals allow designers to consolidate control architectures and eliminate multiprocessor use in high-end systems.

In the TMDSECATCNCD379D design, the F2837x receives EtherCAT data from the ET1100 through either a serial (SPI) interface or an asynchronous parallel memory interface (EMIF). Figure 7 shows the use of EMIF2, but either EMIF can be used to interface to the ET1100. Note that GPIOs 93 and 94 are for future expansion to address a larger memory space. They are not used in the example code.

![Figure 7. EMIF Interface to ET1100 EtherCAT Slave Controller](image)

![Figure 8. SPI Interface to ET1100 EtherCAT Slave Controller](image)
2.4.2 **DP83822**

The DP83822 is a low power single-port 10/100 Mbps Ethernet PHY. It provides all physical layer functions needed to transmit and receive data over both standard twisted-pair cables or connect to an external fiber optic transceiver. Additionally, the DP83822 provides flexibility to connect to a MAC through a standard MII, RMII or RGMII interface.

2.4.3 **TPS62063**

The TPS6206x is a family of highly efficient synchronous step-down DC-DC converters. They provide up to 1.6-A output current. With an input voltage range of 2.7-V to 6-V, the device is a perfect fit for power conversion from 5-V or 3.3-V system supply rails. The TPS6206x operates at 3-MHz fixed frequency and enters power save mode operation at light load currents to maintain high efficiency over the entire load current range. The power save mode is optimized for low-output voltage ripple. For low noise applications, the device can be forced into fixed frequency PWM mode by pulling the MODE pin high.

In this reference design, the converter enables power to be supplied from either the controlCARD or an external 5-V source.

2.4.4 **SN74LVC1G07**

This single buffer/driver is designed for 1.65-V to 5.5-V $V_{cc}$ operation. The output of the SN74LVC1G07 device is open drain and can be connected to other open-drain outputs to implement active-low wired-OR or active-high wired-AND functions. The maximum sink current is 32 mA.

In this design, the open-drain buffer connects a GPIO from the F28379D controlCARD to the ET1100 EtherCAT slave controller reset pin, thereby, enabling independent reset of both devices.

2.4.5 **SN74CBTLV3245A**

The SN74CBTLV3245A provides eight bits of high-speed bus switching in a standard '245 device pinout. The low on-state resistance of the switch allows connections to be made with minimal propagation delay. The device is organized as one 8-bit switch. When output enable (OE) is low, the 8-bit bus switch is on, and port A is connected to port B. When OE is high, the switch is open and the high-impedance state exists between the two ports.

In this TI Design, the bus switch isolates selected ET1100 outputs from the F28379D controlCARD GPIOs when the EMIF interface is not used (SPI mode). Note that the bus switches are optional in a design using only a single interface type.

2.4.6 **SN74CBTLV3257**

The SN74CBTLV3257 device is a 4-bit 1-of-2 high-speed FET multiplexer/demultiplexer. The low on-state resistance of the switch allows connections to be made with minimal propagation delay. The select (S) input controls the data flow. The FET multiplexers/demultiplexers are disabled when the output-enable (OE) input is high.

This multiplexer connects selected GPIOs to the ET1100 depending on the interface mode (EMIF or SPI). Note that the multiplexer is optional in a design using only a single interface type.

2.4.6.1 **Beckhoff ET1100 EtherCAT Slave Controller (ESC)**

The ET1100 device is an EtherCAT Slave Controller (ESC). It handles all communications between the EtherCAT fieldbus and the F2837x interface (either SPI or EMIF).

For more information, see [http://www.beckhoff.com](http://www.beckhoff.com).
2.4.7 TMS320F2837xD Delfino Microcontroller Functional Diagram

Figure 9. TMS320F2837xD Functional Diagram
2.4.8 Ethernet PHY Functional Diagram

Figure 10. DP83822 Functional Diagram

2.4.9 SN74CBTLV3245A Functional Diagram

Figure 11. SN74CBTLV3245A Functional Diagram
2.4.10 SN74CBTLV3257 Functional Diagram

![SN74CBTLV3257 Functional Diagram](image)

Figure 12. SN74CBTLV3257 Functional Diagram

2.4.11 ET1100 Functional Diagram

3 Getting Started (Hardware)

This document describes an F28379D controlCARD adapter board. The adapter board can support either an EMIF or an SPI interface.
3.1 EtherCAT Master Configuration Using TwinCAT3

3.1.1 Download and Install TwinCAT3 From the Beckhoff website

The TwinCAT3 software is available from the Beckhoff website at http://www.beckhoff.com. Follow the left sidebar to Download → Software → TwinCAT 3 → TE1xxx | Engineering. As of this writing, the most recent version of this software is TwinCAT 3.1 – eXtended Automation Engineering (XAE) v 3.1.4022.0.

3.1.2 Verify the TwinCAT Runtime is Active

1. Check for the EtherCAT icon in the notification panel in the lower-right corner as shown in Figure 15. If this is absent, open the notification panel and check in the popup window for the TC Switch Runtime. Right click on this icon and select Tools → TC Switch Runtime.

   ![Figure 15. TwinCAT Runtime Icon in Windows Toolbar](image)

2. Verify that the TC Switch Runtime is active. The “Deactivate” button should be showing as illustrated in Figure 16. If this button reads “Activate”, click that button to start the TC Switch Runtime.

   ![Figure 16. TwinCAT Runtime Dialog Box](image)

3. If the TC Switch Runtime is not found in steps 1 and 2 above, then locate the runtime in the file system. A typical location is: “C:\TwinCAT\TcSwitchRuntime\TcSwitchRuntime.exe”. Note that it is NOT commonly found in the Start Menu.
3.2 Start TwinCAT3 and Verify That TwinCAT is Running in Visual Studio

1. Locate the TwinCAT XAE, which can be found in one of three places:
   (a) Start menu → under Beckhoff → TwinCAT3 → TwinCAT XAE (VS 2010).
   (b) Desktop icon is shown in Figure 17.
   (c) Notification panel icon → right click and select TwinCAT XAE (VS 2010).

2. Verify that TwinCAT is running under Visual Studio. “TwinCAT” and “PLC” should both appear in the main toolbar as shown in 1. If these menu items are not shown, then the TC3 runtime is NOT running. Go back to step Figure 19 to restart the TC3 runtime.

3. Open a new EtherCAT project.
   (a) File → New → Project.
4. Verify that a Realtime Ethernet Adapter is installed.
   (a) TwinCAT $\rightarrow$ Show Realtime Ethernet Compatible Devices
   If no RT adapter is installed, select one from the list of Compatible devices and click “Install”, then exit this popup.

5. Scan for the newly installed Realtime adapter by clicking TwinCAT $\rightarrow$ Scan.
   (a) A popup indicating TwinCAT has found the adapter that should appear (see Figure 22).

(b) Click “OK”, then click “Yes” to the following two popups (see Figure 23).

---

Figure 21. TwinCAT3 EtherNet Adapter Dialog

Figure 22. TwinCAT3 Discovery of Ethernet Adapter

Figure 23. TwinCAT3 Master Scan for Slaves and Free Run Activation
(c) The screen view shown in Figure 24 should now be visible in TwinCAT3, indicating that the Master and Slave are connected and prepared for use. Note that “Box 1” appears at the bottom of the image, indicating that TwinCAT has discovered the EtherCAT slave. If this is the first time that the slave has been connected and the EEPROM has not yet been programmed, the “Box n ()” label (for example, “TI_C2KESC”) will not be visible.

Figure 24. TwinCAT Solution Explorer Showing EtherCAT Master (Device 2) and Slave (Box1, TI_C2kESC)

6. The EtherCAT Master is now ready for communication with the Slave device.
3.3 Configuring the EtherCAT Adapter Board Interface for EMIF or SPI Operation

The EtherCAT adapter board must be configured prior to power-up to select between the EMIF or SPI interface from the C28x to the ET1100 slave controller. Options for power source and interface type are available through jumpers and/or DIP switches as described in Figure 25 and Table 2.

![Figure 25. EtherCAT Adapter Board Interface](image)

Table 2. EtherCAT LED and Switch Usage Descriptions

<table>
<thead>
<tr>
<th>NAME</th>
<th>OPTIONS</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Switches/Jumpers</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SW1</td>
<td>L – SPI</td>
<td>Selects between EMIF and SPI Interface Modes</td>
</tr>
<tr>
<td></td>
<td>R – EMIF</td>
<td></td>
</tr>
<tr>
<td>J3</td>
<td>1-2 off-board</td>
<td>Off-board: 3.3 V is provided directly from attached controlCARD</td>
</tr>
<tr>
<td></td>
<td>2-3 on-board</td>
<td>On-board: 3.3 V is generated by the on-board regulator from a separate 5 V</td>
</tr>
<tr>
<td></td>
<td></td>
<td>supply.</td>
</tr>
<tr>
<td><strong>LEDs</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUN LED</td>
<td>State Machine Status (1)</td>
<td>Off: ET1100 Device is in INIT state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On: ET1100 Device is in Operational state.</td>
</tr>
<tr>
<td>DS2/PWR LED</td>
<td>3.3 V Power</td>
<td>ON indicates 3.3 V is being supplied to the board. For details, see the schematics in Figure 38.</td>
</tr>
</tbody>
</table>

3.4 Preparing the Adapter Board for EtherCAT Communication Using TwinCAT3

After installing the TwinCAT3 software in the previous section and verifying connectivity between the EtherCAT Master and the slave node, the ESC EEPROM must be programmed to enable communication to the C28x device over either the EMIF or SPI PDI. The following procedure writes the binary file associated with the selected PDI type into the EEPROM:

1. After starting up the TwinCAT software in Section 3.1, the screen should look something like Figure 26. Double clicking the EtherCAT slave (labelled “Box 1” in the figure) brings up the EtherCAT properties window on the right. Click “Advanced Settings”.

![Figure 26. TwinCAT Project EtherCAT Tab](image)

Submit Documentation Feedback
2. In the advanced settings popup windows, select “Smart View” to bring up detailed information about the EtherCAT Slave PDI. Click “Write E2PROM”. Note that, prior to initialization, this view shows a “blank” configuration.

![Figure 27. TwinCAT “Smart View” Slave Properties Window Showing Blank Slave](image)

3. Click “Browse” to find the desired EEPROM binary associated with either the SPI or EMIF interface in the TMDSECATCNC379D_PDI_HAL_API directory downloaded from the project site.
   (a) pdi_test_app_spi.bin – for SPI interface
   (b) pdi_test_app_emif.bin – for EMIF interface
   (c) Click “OK”.

![Figure 28. TwinCAT3 EEPROM File Dialog](image)
4. After TwinCAT writes the EEPROM (in this case for the SPI), the following “Smart View” window showing a valid configuration with PDI Type = “SPI slave” should appear (see Figure 29).

![Smart View Window](image)

Figure 29. TwinCat "Smart View" Slave Properties Window Showing Programmed EEPROM

5. The EtherCAT Slave controller is now prepared for communication with the MCU.
3.5 **EEPROM Configuration Values**

The first 15 bytes of the EEPROM hold MCU-related configuration. This is readable via several ESC register addresses. The options used in these demonstrations are:

<table>
<thead>
<tr>
<th>ESC Register Address[Bit]</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x140</td>
<td>0x05 – SPI</td>
<td>PDI type</td>
</tr>
<tr>
<td></td>
<td>0x08 – EMIF</td>
<td></td>
</tr>
<tr>
<td>0x141[0]</td>
<td>Off</td>
<td>Device emulation</td>
</tr>
<tr>
<td>0x141[1]</td>
<td>All Ports On</td>
<td>Enhanced Link Detection</td>
</tr>
<tr>
<td>0x141[3:2]</td>
<td>DC Latch + Sync Unit</td>
<td>DC Units power saving</td>
</tr>
<tr>
<td><strong>ASYNC16 Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0x150[1:0]</td>
<td>Push-pull active high</td>
<td>BUSY output driver/polarity</td>
</tr>
<tr>
<td>0x150[3:2]</td>
<td>Push-pull active low</td>
<td>IRQ output driver/polarity</td>
</tr>
<tr>
<td>0x150[4]</td>
<td>Active low</td>
<td>BHE polarity</td>
</tr>
<tr>
<td>0x150[7]</td>
<td>Active low</td>
<td>RD polarity</td>
</tr>
<tr>
<td>0x152[0]</td>
<td>Normal delay</td>
<td>Read BUSY delay</td>
</tr>
<tr>
<td>0x151[2]</td>
<td>LATCH input</td>
<td>SYNC0/LATCH0</td>
</tr>
<tr>
<td>0x151[3]</td>
<td>On</td>
<td>Map to AL Event Request</td>
</tr>
<tr>
<td>0x151[6]</td>
<td>LATCH input</td>
<td>SYNC1/LATCH1</td>
</tr>
<tr>
<td>0x151[7]</td>
<td>On</td>
<td>Map to AL Event Request</td>
</tr>
<tr>
<td><strong>SPI Settings</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0x150[1:0]</td>
<td>Mode 3</td>
<td>SPI mode</td>
</tr>
<tr>
<td>0x150[3:2]</td>
<td>Push-pull active low</td>
<td>SPI_IRQ output driver/polarity</td>
</tr>
<tr>
<td>0x150[4]</td>
<td>Active low</td>
<td>SPI_SEL polarity</td>
</tr>
<tr>
<td>0x150[5]</td>
<td>Normal sample</td>
<td>Data Out sample mode</td>
</tr>
<tr>
<td>0x151[1:0]</td>
<td>Push-pull active low</td>
<td>Output driver/polarity</td>
</tr>
<tr>
<td>0x151[2]</td>
<td>SYNC output</td>
<td>SYNC0/LATCH0</td>
</tr>
<tr>
<td>0x151[3]</td>
<td>On</td>
<td>Map to AL Event Request</td>
</tr>
<tr>
<td>0x151[5:4]</td>
<td>Push-pull active low</td>
<td>Output driver/polarity</td>
</tr>
<tr>
<td>0x151[6]</td>
<td>SYNC output</td>
<td>SYNC1/LATCH1</td>
</tr>
<tr>
<td>0x151[7]</td>
<td>On</td>
<td>Map to AL Event Request</td>
</tr>
</tbody>
</table>

4 **Getting Started (Firmware)**

Figure 30. TMDSECATCNCD379DKIT controlSUITE Folders

- Generated_SSL
- SSCToolC28xPatch
- TMDSECATCNCD379D_EchoBack_Demo
- TMDSECATCNCD379D_EtherCAT_Solution_Ref
- TMDSECATCNCD379D_PDI_HAL_API
The firmware package for this kit consists of a Process Data Interface (PDI) demo using the hardware abstraction layer (HAL), C2000 patches for the Beckhoff slave stack code (SSC), a reference project for the SSC, and a precompiled echo-back demo that uses the patched SSC. All of this software is designed for C2000 F2837x MCUs. Each demo has build configurations for SPI and EMIF. To change between these interfaces, set both of the switches in switch block SW1 (Figure 25) on the adapter board accordingly.

The PDI demo sets up and tests basic communication between the EtherCAT master and the EtherCAT slave controller. The echo-back demo shows an example of higher-level communication between the master and slave.

NOTE: For EtherCat Developers: The EtherCAT Technology Group (ETG) recommends membership for parties implementing EtherCAT in a machine or machine line. For additional information about EtherCAT and ETG membership, see the following links:
- EtherCAT FAQs: https://www.ethercat.org/en/faq.html
- EtherCAT Technology Group site: https://www.ethercat.org

4.1 PDI HAL Test Demo

The PDI test application contains a hardware abstraction layer (HAL) that handles all of the configuration details for the EMIF or SPI interface. This Code Composer Studio™ (CCS) 7.x project also performs some simple read/write tests to verify correct functioning of communication with the ET1100 slave controller.

The CCS project files for pdi_hal_test_app can be downloaded from the design directory at http://www.ti.com/tool/TMDSECATCNCD379D. The files install into the C:\TI\controlSUITE\development_kits\TMDSECATCNCD379DKIT directory. Once downloaded, import this project into CCS 7.0 or later using the procedure below:

1. File → Import… (an “Import” popup window appears).
2. Select “Code Composer Studio” → CCS Projects. Click “Next”.
3. Use “Select search-directory” and click “Browse” to find the pdi_hal_test_app source directory.
4. Select pdi_hal_test_app from the list of Discovered projects:
   (a) Leave the “Automatically import referenced projects” box checked.
   (b) Checking the box for “Copy projects into workspace” is optional.
   (c) Click “Finish”. The CCS project will appear in the project explorer window.
4.1.1 Test Setup

The main purpose of this test is to demonstrate the usage of the PDI between the C28x processor and the ET1100 EtherCAT Slave Controller.

Figure 31. EtherCAT Test Setup

The test setup in Figure 31 shows a C2000 F28379D controlCARD with attached EtherCAT adapter board and two PCs. The left PC connects to the adapter board through a standard Ethernet cable connected to Port 0, and runs TwinCAT 3 software, which provides EtherCAT Master functionality. The right PC connects to the controlCARD directly through the USB connector and runs the EtherCAT Hardware abstraction layer (HAL) software on the CCS 7.x development environment. The HAL software in this example performs the following functions:

- Initialize the C28x hardware and the selected PDI interface (SPI or EMIF)
- Execute reads/writes to the ET1100 User RAM
- Execute reads from ET1100 register space

The intent of this project is to demonstrate the usage of the PDI. Therefore, no EtherCAT stack is included in this demo.

Note that the HAL software supports both the SPI and EMIF as PDI interfaces. The user must choose the proper settings when building the project. Correct jumper settings on the adapter board are also required for proper operation. These settings are described in Section 3.3.
4.1.1.1 Running Simple ESC Interface Test on C28x

After downloading the software from the project directory at [http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT](http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT) and importing the project into CCS, perform the following steps to exercise the PDI HAL:

1. Open the example project pdi_hal_test_app in CCS. The file pdi_test_appl.c has the main routine. The following code is of interest:

```c
80 void main()
81 {  
82   //Initialize C28x MCU and HAL interface
83   ESC_HWinIt();
84   
85   //setup PDI for test
86   ESC_setupPDItestInterface();
87   
88   while(1)
89   {  
90     //Keep updating local RAM with ET1100 registers for debug
91     ESC_debugUpdateESCRegLogs();
92     DELAY_US(1000 * 500);
93   }
94
95  }
```

Figure 32. CCS Example Project: pdi_hal_test_app

2. Right click on the project and set the desired active build configuration. Figure 33 shows the available configurations, which provides options for program storage (flash and RAM) and interface type (EMIF, SPI-C):
Figure 33. EtherCAT HW Abstraction Layer Project
For this example, choose build configuration (4_F2837xD_CCARD_SPIC_RAM) by right clicking on the project name and selecting “Build Configuration” → Set Active → (4_F2837xD_CCARD_SPIC_RAM).

Start TwinCAT3 on the EtherCAT Master PC as described in Section 3.2. Note that double clicking the EtherCAT slave node (“Box 2” in Figure 34) opens up a properties windows, from which the “Advanced Settings window” can be opened. This is used later in the demo.

![Figure 34. TwinCAT3 Advanced Settings Dialog](image)

3. Start the debugger and open the memory browser window as shown in Figure 35. The “escRegs” data array contains a list of ET1100 register addresses and values. These get updated in the `ESC_debugUpdateESCRegLogs()` function.

![Figure 35. Device Debug Memory Window at INIT Time](image)

**NOTE:** The ESC RUN LED will NOT be on during the memory tests, which is described in the following sections. For more information, see the ET1100 data sheet.

**ESC RAM READ TEST**
4. Open up the “advanced settings” window in TwinCAT3 and go to the memory browser at ESC Access → Memory and view Start Offset = 1000h as shown in Figure 36.

![Figure 36. TwinCAT3 Memory Read Window](image)

5. In CCS, view the Expressions window and add “escRegs” as a watched expression. Note that, as data is entered into the window in TwinCAT, the values read on the CCS side are identical.

![Figure 37. EtherCAT Write to Memory From CCS Project](image)

ESC RAM WRITE TEST
6. **Figure 38** shows program control after execution of the first 32-bit write and 32-bit read from PDI to ET100 address 0x1000.

![Figure 38. CCS Project Write to EtherCAT Slave](image)

7. The TwinCAT Master view of the ESC memory address showing the results of the write from CCS.

![Figure 39. TwinCAT3 Master Read of Data Written to EtherCAT Slave](image)

### 4.1.1.2 TwinCAT3 Troubleshooting

Common issues in TwinCAT3 usage:

- **Problem:** EtherCAT network fails to initialize
  - **Other Descriptions:** “Reload Devices” fails, “Scan” for devices fails, “Restart EtherCAT in config mode” fails.

- **Solutions:**
  - Power-cycle the controlCARD
  - Check to make sure a RealTime Ethernet Driver is available.
    TwinCAT → “Show RealTime Ethernet Compatible Devices”. This opens a popup window below.
    - Look for the first line “Installed and ready to use devices (realtime capable)”.
      In this example, there are NO adapters installed!
    - Select a compatible device; here it is “Local Area Connection → Intel ....” and click “Install”.
    - Close the window by clicking “X” in the upper right corner.
Figure 40. TwinCAT3 Ethernet Adapter Installation
4.1.2 Other Interfaces

It is possible to use EMIF1, SPI-A, or SPI-B to communicate with the ET1100, although the F28379D
controlCARD and adapter board hardware do not support this directly. This functionality is implemented in
the software and can be used on a custom board.

To use EMIF1, select one of the EMIF build configurations (_1_F2837xD_CCARD_EMIF_FLASH or
_2_F2837xD_CCARD_EMIF_RAM). Uncomment the #define for USE_EMIF1 on line 526 of
etherCAT_slave_c28x_hal.h:

```
526 // #define USE_EMIF1 // LAUNCHXL Rev2.0 J9 connector option for accessing ET1100
528 #ifdef CONTROLCARD // for Controlcard definitions
530 #ifdef INTERFACE_SPI
531 #ifdef USE_EMIF1
532 #error "user cannot use EMIF1 with SPI Configurations of project"
533 #endif
534 extern void ESC_SPIInit(void);
535 extern void ESC_SPIRead(uint16_t offset_addr, uint16_t numbytes, uint16_t* buffer);
536 extern void ESC_SPIWrite(uint16_t offset_addr, uint16_t *wrdata, uint16_t numwords);
537 #define ESC_SPI_INT_GPIO 136
538 #endif
540 // on ET1100 it is 8KB of RAM
541 #define ESC_PTRAM_START_ADDRESS_OFFSET 0x1000
542 #define ESC_PTRAM_END_ADDRESS_OFFSET 0x2FFF
544 #define ESC_SYNC0_GPIO 113
545 #define ESC_SYNC1_GPIO 114
546 #define ESC_RESET_ET1100_GPIO 137
547 #define ESC_EEPROM_LOADED_GPIO 119
549 #else // #endif INTERFACE_SPI
550 extern void setup_emif1_pinmux_async_16bit(Uint16 cpu_sel);
552 extern void ESC_EMIF2SetupPinmuxAsync16bit(Uint16 cpu_sel);
553 extern void ESC_EMIF2WriteBlock(uint16_t* pData, uint16_t offset_addr, uint16_t numwords);
555 #ifdef USE_EMIF2 // Launchpad XL EMIF1 J9 connector option
556 // on ET1100 it is 8KB of RAM
557 #define ESC_PTRAM_START_ADDRESS_OFFSET 0x1000
558 #define ESC_PTRAM_END_ADDRESS_OFFSET 0x2FFF
559 #define ESC_EMIF2_INT_GPIO 107
560 #define ESC_SYNC0_GPIO 86
561 #define ESC_SYNC1_GPIO 87
562 #define ESC_RESET_ET1100_GPIO 108
563 #define ESC_EEPROM_LOADED_GPIO 52 // this was 33 on LAUNCHXL Rev1.1
565 #else // #ifdef USE_EMIF1 // USE EMIF2
```

Figure 41. Code Change for Using EMIF1
To use another SPI module, select one of the SPI build configurations (_3_F2837xD_CCARD_SPIC_FLASH or _4_F2837xD_CCARD_SPIC_RAM). Add USE_SPIA or USE_SPIB to the predefined symbols list in the project build options. Remove USE_SPIC from the list:

```
Figure 42. Project Configuration Change for Using SPI-A or SPI-B

This change affects the code in etherCAT_slave_c28x_hal.c:

```
1032 //-----------------------------
1033 #ifdef INTERFACE_SPI
1034 //TXCnt=0;
1035 SPI_XmitInProgress=0;
1036
1037 //InitSpiaGpio();
1038 #ifdef USE_SPIA
1039     SpixRegs = &SpiaRegs;
1040     ESC_SPIAGpioInit();
1041 #elif USE_SPIB
1042     SpixRegs = &SpicRegs;
1043     ESC_SPICGpioInit();
1044 #else
1045     SpixRegs = &SpibRegs;
1046     ESC_SPIBGpioInit();
1047 endif
1048 ESC_SPIInitFIFO();
```

Figure 43. SPI Selection and GPIO Configuration Code
4.2 EchoBack Demo

The EchoBack demo is a precompiled demonstration of the slave stack code. It emulates a bank of switches (inputs) and LEDs (outputs). The master controls the LEDs. The slave loops back the virtual LED signals into the virtual switches, so the master can read back the output state.

![Figure 44. EchoBack Demo Files](image)

4.2.1 Slave Setup

On the slave side, simply load the .out file for the chosen interface (ASYNC16 or SPI) using the CCS debugger. Run the program. To observe the variables, right-click in the Expressions window and choose Import. Select the expressions_window_inputsOutputs.txt file from the EchoBack demo directory, which is shown above.

4.2.2 Master Setup

The first step on the master side is to program the ET1100’s EEPROM using TwinCAT. Unlike the PDI demo, this time the EEPROM is programmed using provided XML files, which can be seen in the directory listing above. Copy these XML files into the C:\TwinCAT\3.1\Config\Io\EtherCAT directory. Follow the same procedure as for the PDI demo (described in the Getting Started (Hardware) section of this document), but instead of clicking on Browse to select a binary EEPROM file, choose the appropriate TI option from the Available EEPROM Descriptions.
Once the EEPROM is programmed, scan for devices again. If you've previously used another EtherCAT configuration such as the PDI demo, you will be prompted to overwrite the box description. To do so, click on Copy All, then OK.
If the demo is running on the slave slide, a TwinCAT master can be used to toggle the LEDs and read the switch states. To toggle an LED, expand the box in the Solution Explorer pane. Click on "LEDs process data mapping" to see a list of the LEDs. Right-click on an LED and choose one of the Online Write options to set the LED value. The written value should appear immediately in the list.
Figure 47. Writing to the LEDs

The LED values are looped back to the switches. The switches can be viewed by clicking on "switches process data mapping". Their values should match the LED values seen in "LEDs process data mapping".
Figure 48. Reading the Switches

This shows that full loopback has been achieved. The master can both read from and write to the slave.

4.3 Slave Stack Code

For information on the slave stack code patches as well as build and debugging instructions, see the TMDSECATCNCD379D EtherCAT Solution Reference Guide (SPRUIG9).
STANDARD TERMS FOR EVALUATION MODULES

1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions set forth herein but rather shall be subject to the applicable terms that accompany such Software.

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned, or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production system.

2 Limited Warranty and Related Remedies/Disclaimers:

2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License Agreement.

2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM. User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10) business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day warranty period.

3 Regulatory Notices:

3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit to determine whether to incorporate such items in a finished product and software developers to write software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:

This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel d'usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.

3.3 Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lds/ti_ja/general/eStore/notice_01.page 日本国内に輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs (which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of Japan.
2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to EVMs, or
3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.
【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けていないものがあります。技術基準適合証明を受けていないものご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。

1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。

上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

日本テキサス・インターナショナル株式会社
東京都新宿区西新宿6丁目24番1号

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lfds/ti_ja/general/eStore/notice_02.page

電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http://www.tij.co.jp/lfds/ti_ja/general/eStore/notice_02.page

3.4 European Union

3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

4 EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or property damage. If there are questions concerning performance ratings and specifications, User should contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit components may have elevated case temperatures. These components include but are not limited to linear regulators, switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the information in the associated documentation. When working with the EVM, please be aware that the EVM may become very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems. User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees, affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal, state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as accurate, complete, reliable, current, or error-free.
6. **Disclaimers:**

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSES OR ANY OTHER THIRD PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. **User's Indemnity Obligations and Representations.** User will defend, indemnify and hold TI, its licensors and their representatives harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, "Claims") arising out of or in connection with any handling or use of the EVM that is not in accordance with these terms. This obligation shall apply whether Claims arise under statute, regulation, or the law of tort, contract or any other legal theory, and even if the EVM fails to perform as described or expected.

8. **Limitations on Damages and Liability:**

8.1 General Limitations. In no event shall TI be liable for any special, collateral, indirect, punitive, incidental, consequential, or exemplary damages in connection with or arising out of these terms or the use of the EVMs, regardless of whether TI has been advised of the possibility of such damages. Excluded damages include, but are not limited to, cost of removal or reinstallation, ancillary costs to the procurement of substitute goods or services, retesting, outside computer time, labor costs, loss of goodwill, loss of profits, loss of savings, loss of use, loss of data, or business interruption. No claim, suit or action shall be brought against TI more than twelve (12) months after the event that gave rise to the cause of action has occurred.

8.2 Specific Limitations. In no event shall TI's aggregate liability from any use of an EVM provided hereunder, including from any warranty, indemnity or other obligation arising out of or in connection with these terms, exceed the total amount paid to TI by User for the particular EVM(s) at issue during the prior twelve (12) months with respect to which losses or damages are claimed. The existence of more than one claim shall not enlarge or extend this limit.

9. **Return Policy.** Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s) will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s), excluding any postage or packaging costs.

10. **Governing Law:** These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas, without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas. Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief in any United States or foreign court.
IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated ('TI') technical, application or other design advice, services or information, including, but not limited to, reference designs and materials relating to evaluation modules, (collectively, "TI Resources") are intended to assist designers who are developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you (individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of this Notice.

TI's provision of TI Resources does not expand or otherwise alter TI's applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections, enhancements, improvements and other changes to its TI Resources.

You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications (and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any testing other than that specifically described in the published documentation for a particular TI Resource.

You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI RESOURCES ARE PROVIDED "AS IS" AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-compliance with the terms and provisions of this Notice.

This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services. These include, without limitation, TI's standard terms for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm), evaluation modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2017, Texas Instruments Incorporated